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JReview Modules

1. Basics and Running Existing Reports
2. Modifying Existing Reports
3. Creating ad hoc Reports
4. Filters and Patient Selection Criteria



JReview Module 1

Basics and Running Existing Reports



Module 1 Outline

 Introduction
 Basics/Navigation

 Login
 Review of the Interface (or user screens) and Reports
 Run existing reports
 Export reports to excel and open it

 Demo



Introduction
 JReview is the new version of I-Review ("Integrated Review")
 Companion reporting tool in C3D family 
 Intuitive and user-friendly
 Allows design of clinical data reports and to perform simple analyses

 Only allows access to your C3D protocols and Sites
 Java based application

 Requires the Java Runtime Environment version1.8.0  later installed. 
CCR JReview Reports Instructions/Manual
https://ccrod.cancer.gov/confluence/download/attachments/161841157/I
Review%20Reports_v3.0_manual.pdf?version=1&modificationDate=15
11108367993&api=v2

 Vendor’s Manual
https://ccrod.cancer.gov/confluence/download/attachments/161841157/JReview%20
User%20Manual%209.2.6.pdf?version=1&modificationDate=1511108376043&api=v2

 Contact NCICB for problems/requests
 240-276-5541 (Toll free: 888-478-4423) or NCIAppSupport@nih.gov

https://ccrod.cancer.gov/confluence/download/attachments/161841157/IReview%20Reports_v3.0_manual.pdf?version=1&modificationDate=1511108367993&api=v2
https://ccrod.cancer.gov/confluence/download/attachments/161841157/JReview%20User%20Manual%209.2.6.pdf?version=1&modificationDate=1511108376043&api=v2
mailto:NCIAppSupport@nih.gov


JReview Login

1. Click on the JReview button;
2. Click on the Open button;
3. Enter your C3D:

1. User Name;
2. Password;
3. ncidb-p253.nci.nih.go:ocprod

for the Database Server (leave 
SAS Server empty);

4. Click on the OK button.

Go to the Login page:
https://octrials-rpt.nci.nih.gov/
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https://octrials-rpt.nci.nih.gov/


JReview Login
 The following message appears if an invalid C3D account and/or password is used:

 If your C3D password is about to expire, the warning message below displays when you 
are logging into JReview saying. If it is the last day, remember to change the password in 
C3D, otherwise your account will get locked overnight.

 Three failed logins attempts will your C3D account just like in C3D RDC. You will have to 
contact the C3D Help Desk to have your account unlocked.



JReview Interface



Accessible Studies

Studies you have access to

■ Studies that you have access to are listed in a folder with 
the Principal Investigator’s name. "$Current" in name of 
the study indicates live data.



Saved Reports

Saved Reports

■ The Output Specification area lists 
the reports, saved by you and other 
users, that are available for the 
selected study.

■ The reports are organized in folders.



Output Specifications
 Reports can be saved as Private or Public.

 A Private report is only accessible by the user that 
created it.

 Use the Output Specification drop-down 
to choose which reports to show:
 Private – shows only reports created by you 

and available to you in the study;
 Public – shows reports available to anyone 

with access to the study (even reports saved 
by other users;

 All – same as Private and Public combined.
 Favorites – Reports marked as Favorites.



Execute a Saved Report
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Report Output



To Execute an Existing Report
1. Click on folder with the PI’s name and click on the desired study 

(use $CURRENT for live production data);
2. Optionally, change the Output Specification drop-down to Private 

or Public;
3. Double-click on folder to open and list the reports in it;
4. Double-click on the name of a saved report to execute it.

The report executes for a few seconds and the output will be 
presented in a separate tab labeled with the report title.

Note: Lab reports on studies with a lot of lab data can take a few 
minutes to execute.
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How to Export Reports

Once a report has completed 
executing:

1. Click on the Report Output
window;

2. Click on File menu item;
3. Select the Export menu 

option;
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How to Export Reports

4. Save dialog window will 
appear;

5. Select a location (desktop, 
my documents..) to save 
the report;

6. Enter a file name with 
extension (use .xls for 
spreadsheets, .txt for text 
files);

7. Click Save button.



CCR JReview Manual



CCR JReview Manual

 Link to JReview Manual:
https://ccrod.cancer.gov/confluence/download/attachments/161841157/IReview%20Rep
orts_v3.0_manual.pdf?version=1&modificationDate=1511108367993&api=v2

 General Instructions on how to execute saved reports, 
export output, customize saved reports, create your own 
reports, set filters and  save report.

 Catalog of template reports that can be used as is or as a 
starting point for your own custom reports.

 Since studies have their peculiarities and sometimes 
deviate from the CCR Standard eCRFs, some of the saved 
template reports might contain items that are not applicable 
to a study. JReview shows a prompt indicating which items 
are not compatible and remove them from the report. It the 
item exists in the study, it most likely has a different name, 
but it still can be added to the report. Module 2 covers 
modifying reports.

https://ccrod.cancer.gov/confluence/download/attachments/161841157/IReview%20Reports_v3.0_manual.pdf?version=1&modificationDate=1511108367993&api=v2


Module 1 Demo

 DEMO
Log-in
Run a Saved Report
Export output to Excel spreadsheet



JReview Module 2

Modifying Existing Reports



Module 2 Outline

 C3D Terminology
 Setting Recommended Preferences
 Oracle/JReview Relationship

 JReview and C3D Correlation
 F1 function

 Open and Modify Saved AE report
 Actual/Decoded, Print change, Sort order
 Save Report
 Demo



C3D Oracle Clinical Terminology

 DCI – Data Collection Instrument (i.e. a CRF!)
 DCM – Data Collection Module (Section or "Tab" of a 

CRF.)
 Question – a single element of a CRF in which datum 

("Response") in entered.
 Non-repeating Question Group – A group of Questions 

that occurs once – ex: Course Initiation CRF.
 Repeating Question Group - A group of Questions that 

occurs more than once – ex: Adverse Events CRF.



Changing Preferences
Default

Recommended



Setting "Preferences"

 Edit JReview Preferences to change the order 
the DCM/Question Groups and Questions are 
listed.

 To change preferences:
1. Click on Edit menu item;
2. Select Preferences menu option;
3. Click on check boxes to enable or disable 

preferences - See recommendations on previous 
slide.



C3D and JReview Correlation
Questions

DCMs

Repeating Group
Questions

Non-Repeating Group



C3D: F1 & Field Help Function

 Displays Oracle Clinical question name and default 
prompt for selected data point.

 Useful in finding out the question’s Default Prompt as it 
appears in JReview.
1. Click on a specific data point on eCRF in C3D:

a) On RDC Onsite studies, press the mouse’s right button and select the "Field 
Help" option;

b) On non RDC Onsite studies, press the keyboard F1 key.
2. A pop-up window appears and shows the data point’s question 

name and default prompt .



F1 and Field Help Function
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RDC Onsite

Non RDC Onsite
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Question’s Default Prompt 



Open and Modify Reports

Right click, then choose open

Report definition in Report Browser



Open and Modify Reports
Right click, then choose open

1. Choose Open in Classic Mode
to open the old interface to edit 
the report design.

2. Optionally, choose Open 
Version to open a previously 
saved version



Modifying Saved Reports

 A saved report can be modified to suit your 
requirements.

 The following changes can be made: 
 Remove Columns
 Rename Columns Headings
 Set Sort Order
 Set Print Change
 Change Function (date format, actual/decoded value)

 The modified report can also be saved for later use.
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Remove Columns

1. Click on the Column Header 1 or 2 to select/highlight the column
2. Select the Edit menu item
3. Select the Cut menu option

Hint: Use the scissors           on the toolbar instead of steps 2 and 3 to 
remove the selected column.



Rearrange Report Column Order
1

1.Click and drag the cell with a number 
above the column to move to the desired 
location and release the mouse button.



Edit Column Heading

2

1

1. Double-click on the Column Header 1 or 2 
to enter edit mode

2. Type in the desired new text

Note: Press the Enter or Tab key or click on 
another cell when done.



Chosen Order
Report Output

Setting Sort Order

Chosen Order

Report Output

 Enter numbers in the Sort Order cells that correspond to the way the report output data is to be sorted.
In this example, the output is sorted first on the patient position ID and then on the patient initials 
alphabetically.

 In this example, the sort order numbers were reversed and now the output is sorted first on the patient initials 
alphabetically and then by patient position ID.

Hints: Optional descending sort is specified by a trailing " D" after the sort order number.
Do not repeat numbers.



Print Change Enabled
 On columns that have a sort order number, it is possible to select the "Print Change" option from the drop-

down list as shown below.
 Data will only display on the output when the value differs from the contents of the cell above.

Warning: Although it is a nice visual cue, sometimes this feature could misled the user into thinking a value is 
missing simply because its display was suppressed since it was the same and the one above. The other issue is 
that an empty cell is exported to the Excel spreadsheet making it hard to sort and filter in the data.



Print Change Disabled
 To disable the Print Change feature, select the empty option from the drop-down as shown 

below.
 The output will always show the contents of the cell and not suppress it.



Change Function
 In the “New Mode” Report Designer interface, it is possible to change a question’s  function 

and choose a different date format or toggle between actual/decoded value without the need 
to remove the question and add it again.

Click on the Function Drop-down



Handling a Panel Items Not Found 
in Saved Reports
 Some saved reports may contain items (questions) that are not applicable to a study.
 When you try to execute or open such saved report, a warning message (see below) indicates 

which items are not found. These items are automatically removed.
 Click "Yes" to proceed and load the rest of the report’s items.
 Click "No" to abort and not load/execute the report.

 Optionally, these items can be replaced with the appropriate ones for your study.
Note: Review Filters and Patient Selection Criteria as well since items are also present there and 
could affect the result of the report.



Saving a Report

1
2

3

 After making changes to the saved report, you are able to save it as a new report 
(necessary if you did not create the saved report) or update it (if you created it).

 Click on the File menu item and then choose the Save As menu option to save the current 
report definition as a new report. Use the menu item Save to update the existing report.

 Click on the Definition tab and enter:
1. The report name in the Description box;
2. Select a folder from the Category drop-down list (or type in the name of a new folder);
3. Enter a brief description about the report in the Summary Information box.



Saving a Report
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 Click on the Access tab and select:
4. Choose whether the report will be Private (only accessible by you) or Public (accessible to all user 

with access to the study) from the Object Storage Location drop-down list;
5. Choose the Object Level radio button Study to make the report only be available in the currently 

selected study; or choose Project to make the report available to all studies associated with the 
current PI selected;

6. Click on the Save button.

Hint: After saving a new report 
that was based on an existing 
report, it is advisable to open the 
newly saved report if you will 
continue modifying it.



Module 2 Demo

 DEMO
Set Preferences
Open Saved Report
Edit Column Order, Remove Questions, 

Change Sort Order and Set Print Change
Save report



JReview Module 3

Creating ad hoc Reports



Module 3 Outline

 Report Browser
 Creating New Reports
 Difference Between Actual and Decoded 

Values
 Choosing Date Format
 Demo



Report Browser
 Report Browser has two basic report types:

 Detail Data Listing – Lists details of selected questions from one 
of more CRFs.

 Summary Data Listing – Allows for displaying counts, averages, 
minimum and maximum values without the details.

 Output of these reports are shown in a grid layout and 
can be exported to an Excel spreadsheet.

 Their "Formatted" counterparts show data in a layout 
that can be exported to a PDF file.

 Detail Data Listing is the most used report type.



Creating a Detail Data Listing Report
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1. Click on the Browse menu item;
2. Click on the Reports menu option.

Hint: Optionally, click on the           toolbar 
icon to open the Report browser.

3. Click on the Type drop-down, 
then click on Detail Data Listing



Creating a Detail Data Listing Report
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Design Area

4. Expand the Enrollment DCM and click on the non-repeating 
data Question Group;

5. Click and drag the desired Question to the design area.



Creating a Detail Data Listing Report
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6. Optionally, click on the Function drop-down 
and change the date format or actual/decoded 
value.

Note:
• Date Questions have a default Function of 

Actual Value which displays in YYYYMMDD 
Format.

• Questions that have a Pick-list have a default 
Function of Decoded Value which is the 
description of the pick-list item. Choose Actual 
Value to display the pick-list item code or 
abbreviation

Hint: 
• Uncheck the AutoRefresh checkbox if the 

report’s output preview is taking a long time to 
complete. 

• Use the Refresh button to manually refresh 
the report’s output preview.



Actual versus Decoded value
 Actual Value: is the actual representation of 

a data point entered in a C3D CRF and 
stored in the database.

 Decoded Value: is the long description of 
the actual value. It is available for questions 
which have pick lists in C3D.

 JReview selects the decoded value by 
default.



Date Formats

 Actual value (yyyymmdd) (ex: 20060422)
 Use this when date sort is needed.

 Oracle Date (dd-mon-yy) (ex: 22-APR-06)
 If used and partial dates exist for the question, then JRreview will show an error message.
 Note: Same format shown in C3D RDC.

 Oracle Dates (mm-dd-yyyy (ex: 04-22-2006) and dd-mm-yyyy (22-04-2006))
 Allows for date calculations in Excel.
 Note: Do not use this format when sorting dates.

Available Date Functions

Sample Output



Important Reports Considerations
 When using multiple CRFs in a report, select CRFs in the same 

chronological order as they would have been filled out according to 
the protocol schema.
 For example: Enrollment, Course initiation, AE, Course Assessment, 

Off-Treatment
 JReview "knows" how to put together data from different CRFs

 By patient position and sometimes by course as well.
 Watch out when combining questions from two or more repeating 

groups
 Results in a Cartesian Product!

 Note on reports with Course End Date for patients still on treatment:
 C3D defaults the current (ongoing) course End Date to "August 15 3501" date.



Module 3 Demo

 DEMO
Create a Detail Data Listing with questions 

from different CRFs and using 
Actual/Decoded value and the various Date 
Formats.

Save the report.



JReview Module 4

Filters and Patient Selection Criteria



Module 4

 JReview Terminology
 Patient Selection Criteria 
 Filters
 Demo



JReview Terminology
 Patient Selection Criteria – Specification of how to subset the patient 

population based on their data.
Ex: (Female Patients) Gender = "F"
 Can be saved as part of the report or independently (Patient Subset).

 Patient Subsets – Saved Patient Selection Criteria! Re-usable across 
reports.
 Listed between studies and output specification sections

 Filter – Criteria specified as part of a report and used to include or excludes 
data (rows or records).
Ex: AE Grade >= 3
 Automatically saved with the report.

Note:
 If you do not use a patient selection criteria, or patient subset, your reports will include data 

from all the patients for the Study Sites you have access to.



Create a Patient Selection Criteria

Selection pop up window
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Select the Patient Selection Criteria 
window and then:

1. Expand the DCM in the 
DCM/Question Groups list and 
select the non-repeating data 
Question Group;

2. Click on a Question to select it;
3. Click on an Operator;
4. Click on the Display Values button;
 Window shows up listing values for the 

selected question

5. Click on the desired value to select 
it;
 To choose multiple values, hold down 

ctrl key when selecting values

6. Click on the ADD expression
button;

7. Click on the OK button when done
 Repeat steps 1-6 to add criterion using 

other questions.

8. Click on the Update Browser button 
to activate Patient Selection Criteria



Save a Patient Selection Criteria
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Select the Patient Selection 
Criteria window and then:

1. Select the File menu item and 
then the Save menu option.

2. On the Access tab, select a 
Project Storage Location drop-
down list:
a) Private – Only you will have access to 

the saved Patient Selection Criteria.
b) Public – Everyone with access to the 

selected study will have access to the 
saved Patient Selection Criteria.

3. Then select the Object Level:
a) Study – Patient Selection Criteria will 

only be available to the selected study
b) Project – Patient Selection Criteria will 

be available to all the studies 
associated with the PI (folder that 
groups the studies.).

1



Save a Patient Selection Criteria
Then click on the Definition tab and:

1. Enter the Name of the Patient 
Selection Criteria being saved in 
the Description area.

2. Select a Category from the drop-
down list. Category is the folder 
name where the criteria will be 
saved. A new Category can be 
created by typing in a new folder 
name.

3. Optionally, enter a brief description 
of the Patient Selection Criteria in 
the Summary Information area.

4. Click on the Save button.
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Note: You cannot update or delete a Patient Subset that was not created by you.



Saving Patient Selection Criteria 
with a Report

 While Filters are 
automatically saved with 
the Report, a Patient 
Selection Criteria is not.

 When saving a Report, 
check the Store Patient 
Selection Criteria? option 
on the Access tab to save 
the Criteria as part of the 
report.

 Next time the Report is 
opened or run, the Patient 
Selection Criteria loads and 
the report only runs for the 
patients that satisfied the 
criteria.



Filter Output

 Filter Output is a criteria used to select which 
data from a CRF should be included in the 
Report’s output (undesired rows are not included 
in the report output)

 Filter Output is always saved as a part of the 
report. 

 The Patient Selection Criteria and Filter Output 
can be used together or individually to meet your 
needs.



Create and Save a Filter
1. From the Report’s Designer 

window, click on the Edit
button located in the Output 
Filter area.

1



Create and Save a Filter
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1. Select a DCM/Question Group;
2. Select a Question;
3. Select a Function;
4. Select an Operator;
5. Click on Display Values button to 

show the list of values stored in 
the database for this study;

6. Click on the desired value to select 
it;
o To choose multiple values, 

hold down ctrl key when 
selecting values

7. Click on the ADD expression 
button;

8. Click on the OK button when done;
 Repeat steps 1-6 to add 

criterion using other 
questions

9. Click on the Save Filter button to 
enable the filter.
Note: The filter specified is then 
displayed on the Output Filter
area.



Patient Selection versus Filter

 Patient Selection Criteria = Patient positions 
selected 
Ex: Patients with Arm A in Course Initiation CRF.

Patients 1, 7 and 22, which have Arm A are 
selected and report runs only for these Patients.

 Filter Output = Observation level subset
Ex: Patient with Serious AEs.

Only patients that have at least one Serious AE 
are selected and report runs only for these 
Patients.



Module 4 Demo and Exercises

 Demo
Using the previously created report with 

enrollment and AE questions create the 
following:
 Create a filter for AEs >= grade 3
 Create Patient selection criteria for "Male"
 Generate report for "Male" patients with          

AE>= grade 3



Questions???
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